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Regin Raghavan Nair
Student ID: 21173281

Configuration Manual

This Document provide detailed instructions about the components that are needed , an the
respective configuration that needs to me done in order to recreate the project environment in
another machine . The project has two major software components called the GNS3 Application
that helps simulating the project environment using the GNS3VM. The GNS3 VM is hosted on
VMware Workstation Pro 16. The Detailed descriptions will be given in the following sections.

Physical Machine Configurations.
The physical machine on which the entire set up was built is a HP Gaming Machine with the
following Configuration.

System Configuration
Operating system Microsoft Windows 11 Home Single Language/64bit
Processor AMD Ryzen 5 3550H- 2100 Mhz, 4 Core(s), 8 Logical Processor(s)
Ram 16 GB
Virtual Memory 9.45 GB
Graphics card 4GB
Virtualization Enabled at Bios

The following stages discuss about installation and configuration of software components needed
for this project.

GNS3:

GNS3 tools is used to simulate the devices such as routers, firewalls, server and other
infrastructure devices , to be tested and evaluated in a sandbox environment. The latest version of
GNS3 2.2.41 is installed on the machine.



€

About Team Thanks to License Agreement

GNS3 2.241
Under GPL v3 license
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Figure 1 GNS3 version

Gns3 installation guide form the GNS3 can be found in the official gns3 website(GNS3 Windows
Install | GNS3 Documentation, no date).

VMware Workstation Pro:

VMware Workstation Pro, developed by VMware, Inc., empowers users to generate and oversee
numerous virtual machines (VMs) on a solitary physical computer. The version used here is the
16.2.4.

D Product Information
Product: ViMware® Workstation 16 Pro

Version: 16.2.4 build-20089737

License Information

Status: Evaluation
Type: Mot applicable
Expiration: 8/25/2023

Additional Information

Host name: SARASWATI

Memory: 14216 MB

Host OS version: Windows 10 Home, 64-bit (Build 22621.1992) 10.0.22621

UT log file: C:\Users\regin\AppData'Local\Temp\vmware-reginivmware-ui-3548.log

Copyright © 1998-2022 YMware, Inc. All rights reserved.

This product is protected by U.S. and international copyright and intellectual property laws. WMwvare products are
covered by one or more patents listed at http://www.vmware.com/go/patents

VMware is a registered trademark or trademark of WMware, Inc. in the United States and/or other jurisdictions.
All other marks and names mentioned herein may be trademarks of their respective companies.
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Figure 2 VMware Workstation Version.


https://docs.gns3.com/docs/getting-started/installation/windows/

The installation guide for VMware workstation pro can be found in the official website(/nstall
Workstation Pro on a Windows Host, no date) [Guide].

GNS3 VM installation:
Step 1:

Download the GNS3 VM from the GNS3 official website’s download section. Once you click on
the download VM option at the bottom of the page, select the hypervisor for which the VM
needs to be downloaded, which in our case is a the VMware workstation. This would down load
a “.OVA “file.

Step 2:

Utilizing VMware Workstation as your hypervisor, move forward with importing the previously
downloaded GNS3 VM image. Launch VMware Workstation, access the "File" menu, proceed to
"Open," and opt for the downloaded GNS3 VM OVA file. Subsequently, adhere to the
instructions displayed on-screen to effortlessly finalize the import procedure. The final screen
after installation is as shown below(GNS3 Windows Install | GNS3 Documentation, no date).
I

File Edit View VM Tabs Help

Library

[ 2 e here tosea. ~]

— — Hardware Qptions
= My Computer

Device Summary Rlamony
[E=]Memory 4.8 GB Specify the amount of memory allocated to this virtual machine. The memory
ka x-2022.3- §|:|§Processors 6 size must be a multiple of 4 MB.
Ubuntu 64-bit 3 ard Disk (SCSD) 19.5cB Memory for this virtual machine: 4940 * | mp
Clone of kali-linu [\ Hard Disk 2 (SCST) 488.3 GB ’ s
(=) CD/DVD (IDE) Using unknown backend
2 Network Adapter Host-only 64 GB
Sl Network Adapter 2 NAT 32 GB
52 Natwork Adapter 3 Bridged (Automatic) 16 GB <
ngsplay Auto detect 8 GB B Maximum recommended memory
4GB - (Memory swapping may
occur beyond this size.)
2 GB
11.7 GB
1GB
31218 M Recommended memory
256 MB
4GB
128 MB
Tl Guest 05 recommended minimum
32 MB
2GB
16 MB
8 MB
4 MB

Figure 3 GNSVM installation


https://docs.vmware.com/en/VMware-Workstation-Pro/17/com.vmware.ws.using.doc/GUID-F5A7B3CB-9141-458B-A256-E0C3EA805AAA.html

Step 3:

Once the GNS3 application and the GNS3 Vm is installed, the next step is to link the GNS3
Application with GNS3VM. Upon launching GNS3 for the first time, you'll encounter the GNS3
Setup Wizard. Alternatively, you can manually initiate the Setup Wizard by clicking Help >
Setup Wizard within the GNS3 application. In the Wizard, opt for Run appliances in a Virtual

machines' and proceed by clicking 'Next":

Step 4:

Prior to advancing with the remaining GNS3-VM configuration steps, it is imperative to set up
the local server settings in GNS3. Confirm the accuracy of the gns3server executable path
(typically C:\Program Files\GNS3 in a default installation) and select a Host binding and Port.
Opting for the 127.0.0.1 local loopback address generally proves to be the most seamless host

binding option.

Local server configuration
Flease configure the following GNS3 local server settings
Server path: |C:\Program Files\GNS3\gns3server.EXE Browse...
Host binding: | 127.0.0.1 v
Port: 3080 TCP -
< Back Next = Cancel

Figure 4 GNS3 Set up wizard 1

Step S:

The Setup Wizard will automatically detect the presence of the GNS3 VM within VMware
Workstation. If the GNS3 VM doesn't appear, utilize the 'Refresh' button and double-check the
accurate import of the VM into VMware Workstation. Modify the vCPU cores and RAM values
based on your computer's capacity, and then proceed by clicking Next'.
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GNS3 VM
In order to run the GNS3 ¥M you must first have VMware or VirtualBox
installed and the GNS3 VM.ova imported with one of these software.
Virtualization software:
®) VMware (recommended)
VirtualBox

The GNS3 VM can downloaded here.
Import the VM in your virtualization software and hit refresh.

VM name:

GMHS3VMM b Refresh

vCPU cores:

6 -

RAM size:

4940 MB =
< Back Next = Cancel

Figure 5 GNS3 setup wizard 2
Step 6:

The following page will present a summary of the chosen settings for the GNS3 VM. It's
possible that a "Please Wait" notification may pop up. This occurrence is entirely normal, as
GNS3 is in the process of initializing the GNS3 VM. The subsequent page will reiterate the
summary of the selected GNS3 VM settings. Should you observe a "Please Wait" pop-up, it is
customary, reflecting GNS3's process of launching the GNS3 VM. Post installation the tool looks
as shown below(GNS3 integration with GNS3 VM | GNS3 Documentation, no date).

GMS3 server wersion: 2.2.41
Release channel: 2.2

YM version: 0.15.0

Ubuntu wersion: focal

Bemu wersion: 4.2.1
virtualization: wmware

KWM support available: True
Uptime: up 0 minutes

IF: 192.168.159.125 FORT: gO

To log in using SSH: ssh gns3@192.168.159.128
Fassword: gns3

To launch the Heh-Ui: http://192.168.159.128

Images and projects are stored in 'sopt/gns3’

Figure 6 GNS3 VM successful integration



Import Appliance to GNS3 (Router)

Navigate to Edit > Preferences > IOS Routers to access the appropriate section. In the New 10S
router template window, opt for running the IOS router on the GNS3 VM and proceed by
clicking '"Next'.

e

General [ IOS router templates

Server
GNS3 VM N —xomaman - Genaral

Packet capture L |

~ Built-in Server =
Ethernet hubs Please choose a server type to run the IOS router.

Ethernet switch
Cloud nodes Server type
~ VPCS
VPCS nodes
~ Dynamips
10S routers
~ 105 on UNIX
10U Devices
~ QEMU
Qemu VMs
~ VirtualBox
VirtualBox VMM
~ VWMware
ViMware VMs
~ Docker
Docker contain

Run this I0S router on a remote computer
® Run this I0S router on the GNS3 WM

Run this I0S router on my local computer

< Back MNext = Cancel

Figure 7 Adding 10S image

Locate the directory where your Cisco 10S images are stored. Select the desired image and press
'Open'. This is recommended for an improved user experience, as decompressing the IOS image
can take a few minutes, even on physical hardware. Click 'Yes' to initiate image decompression.

e & Cloudstoragenode vnc 192.168.159.128:5901
) intemet none
W kali-linux-2022.3-vmware-amd64-1 none

General |IOS router templates W R1 telnet 192.168.159.128:5002

. General W R telnet 192.168.159.128:5003
GNS3 VM -7ann > General

Packet capture

~ Built-in 108 image
Ethernet hubs Please choose an 10S image. € > ~ 1 | B> ReginR > GNS3 > images > I0S
Ethernet switch
Cloud nodes Existing image @) News Image Organize ~ New folder BE- B

v VPCS 105 image:
VPCS nodes

'Dynamips . c7200-adventerprisek9_mw-mz.124-20.T5.image /17 Al IMAGE Fi

Regin - Nationa Name Type

105 routers
~10S on UNIX M Desktop

10U Devices
~ QEMU

Qemu VMs ! Documents #
~ VirtualBox

VirtualBox VM

»

+ Downloads #

& Pictures »

~ VMware ® Music »
VMware VMs
~ Docker ¥ videos »
Docker Contai" L

Slot 5:

Hew

Figure 8 Image import 2

The Name and platform window will emerge. Verify the Platform choice, define the router Name
as needed, and then click 'Next'. A Default RAM setting will be displayed. Ensure you review
your Router's minimum memory prerequisites using the Vendor website.



opt for your preferred Network adapters and proceed to the next step. It's crucial for optimal
GNS3 performance to select an Idle-PC value. If a valid green Idle-PC value isn't shown, click
the 'Idle-PC finder' button to identify one. Once the Idle-PC value is generated, click 'Finish' to
conclude the GNS3 Setup Wizard.

€

Idle-PC e
An idle-pc value is necessary to prevent 105 to use 100%

of your processor or one of its cores.

Idle-PC: |0x606e0510 | Idle-PC finder

< Back Finish Cancel

Figure 9 Idle PC value

The newly added device is now accessible within the GNS3 Dynamips Section(GNS3 integration
with GNS3 VM | GNS3 Documentation, no date).

Kali VM import.

Import kali VM into the VMware workstation using the Guide provided by kali.org (Import Pre-
Made Kali VMware VM | Kali Linux Documentation, no date). Steps are similar to ones
performed to import the GNS3 “.OVA” file. Once successfully imported configure Ram ,
network interfaces, and CPU cores for the VM. The configuration on kali VM used for this
project is as shown below.
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File Edit View VM

Library X

[0 e here tosea.. ~]

= My Computer
GNS3VMM

Tabs

Help

¥ Devices

Memory
Processors
Hard Disk (SCSI)
CD/DVD (IDE)
Metwork Adapter
Metwork Adapter 2
Metwork Adapter 3
USB Controller
Sound Card

2| Serial Port

Display

Figure 10 Kali VM Configuration

kali-linux-2022.3-vmware-a...

[_'D kali-linux-2022.3-vmware-amd64

48 GB

4

80.1 GB
Auto detect
Custom (VMnet0)
Custom (VMnet4)
NAT

Present

Auto detect

Using named pip...

Auto detect

Import the Kali VM and into GNS3 following the steps similar to how the GNS3VM was
integrated with GNS3 application. Post which kali VM should be available for use as in figure

below.
General | VMware VM templates
Server
GNS3 VM B8 ali-linux-2022.3-vmware-amd64 ~ General o
Packet capture - . Template name: kali-linux-2022.3-vmware-amd
clet cap windows VM Template ID: e0ab7a07-a545-4cad-824a-7d
¥ Built-in Server: SARASWATI
Ethernet hubs Headless mode enabled: False
Ethernet switches On close: power_off
Linked base VM: False
Cloud nodes
Console type: none
T VPCS Auto start console: False
VPCS nodes ~ Network
~ Dynamips Adapters: 3
MName format: Ethernet{0}
105 routers
Use any adaptern: False
~ 10S on UNIX Type: e1000

10U Devices
~ QEMU

Figure 11 Kali VM in GNS3

Once all the nodes are imported and start the GNS3 application, the application show a green
notification showing the utilization on resources on physical machine and the VM, this is the
proof of successful installation of all the software components.




Servers Summary @ X
b €3 GNS3 VM (GNS3VMM) CPU 0.6%, RAM 11.1%
b £ SARASWATI CPU 3.7%, RAM 64.0%

Figure 12 Successful installation

Once all the devices are imported and the nodes are connected to appropriate interface as shown
in the figure, the Ip addresses need to be configured to each node as shown in the table below.

Kali-inux-2022.3-vmware-amdéd-1  Ri intermet R Cloudstoragenod

Figure 13 Infrastructure design
The IP address allocation to each node is as shown below.

Table 1 Ip address Details

kali-linux-2022.3-vmware-amd64-

1(FOG node)Eth1 : 12.10.1.2/24
Gigabit ethernet 0/0,0n router R1
connecting to linux machine(FOG). 12.10.1.2/24

Gigabit ethernet 1/0,0n router R1
connecting to Gigabit ethernet 1/0,0n
router R2 of cloud network: 12.1.1.2/24

Gigabit ethernet 1/0,0n router R2
connecting to Gigabit ethernet 1/0,0n
router R1 of FOG network: 12.1.1.4/24

Gigabit ethernet 0/0,0n router R2
connecting to Windows machine(Cloud
Storage). 12.10.2.4/24

Windows Cloudstoragenode (Nic2) : 12.10.2.2/24

Once all the running configuration for R1 and R2 provided in the artifacts are imported into R1
and R2 are imported and after configuring the IP details on the Kali Linux node and Windows
VM network interfaces, we should be able to ping successfully to each node from both directions
verifying connectivity and routing to be in place. The Configuration of VPN is also included in
the configurations.



The devices were fully configured during the building phase of the project and running
configuration were exported so that it can be imported easily into another devices if needs to be
tested on another machine. the scree shot of configuration from the device is as shown below.

@student.ncirl.ie addr

crypto ipsec transform-set 21° 1 _transformset esp-aes
!

crypto map : 1 map 18 ipsec-isakmp

Figure 14 Section of VPN configuration on router RI.

Once all configuration and end to end connection is verified, we can proceed with testing the
environment. The first step begins with taking plaintext data and perform hybrid encryption.

The commands that was followed to perform encryption is as shown in the figure below. Steps
take a sequence of

e AES key generation,
e Public and Private key generation,
e Encryption of data by AES,
e Encryption of AES key by using RSA
e Merging of both encrypted data and certificate.
Note: During the process of key generation the GNUPG would prompt to enter a passphrase for

additional security, this password is used to protect the private key which will be used to decrypt
the data.
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~/Desktop/Encryption.sh - Mousepad

File Edit Search View Document Help
[e b C x n

gpg ——gen-key

openssl rand -out aes_key.bin 32

gpg ——symmetric --cipher-algo AES256 --output encrypted_data.gpg data.txt

gpg —encrypt --recipient reginrnairggmail.com --output aes_key.bin.gpg aes_key.bin

encrypted_data.gpg aes_key.bin.gpg combined_file.gpg

aes_key.bin

Figure 15 Encryption Configuration

Once encryption is done, we can see that the AES key, private and public keys are generated,
along with the encrypted files. Below screenshot shows logs on the kali terminal windows
showing generation of keys and its expiry.

kali@kali: ~/Desktop

File Actions Edit View Help

Real name: Regin Raghavan Nair
Email address: X21173281l1la@astudent.ncirl.ie
You selected this USER-ID:
"Regin Raghavan Nair <X2117328l@student.ncirl.ie>"

Change (N)ame, (E)mail, or (O)kay/(Qluit? O

We need to generate a lot of random bytes. It is a good idea to perform
some other action (type on the keyboard, move the mouse, utilize the
disks) during the prime generation; this gives the random number
generator a better chance to gain enough entropy.

We need to generate a lot of random bytes. It is a good idea to perform
some other action (type on the keyboard, move the mouse, utilize the

disks) during the prime generation; this gives the random number
generator a better chance to gain enough entropy.

gpg: revocation certificate stored as '/home/kali/.gnupg/openpgp-revoc
3BCF99D46D9E2A473F.rev’

public and secret key created and signed.

8-09 [SC] [expires: 2025-08-0
18 3BCF99D46D9E2A473F
Regin Raghavan Nair <X21173281l1l@student.ncirl.ie>
2023-08-09 [E] [expires: 2025-08-08]
checking the trustdb
marginals needed: 3 completes needed: 1 trust model: pgp
depth: © valid: s 5 | signed: (%] trust: -, ©q, On, ©Om,
next trustdb check due at 2025-08-03

~/Desktop

Figure 16 encryption logs



M kali ™ Desktop

aes_key.bin aes_key.bin.gpg combined_file.gpg data.txt

A B

Decrytption.sh encrypted_data.gp Encryption.sh

g

Figure 17 encrypted files and keys

The screen shot below shows the scrambled content when we try opening the encrypted file

using “cat” command in liux.

~/Desktop
combined_file.gpg
L3 elLe'ee 00 eeDoccioe7Xe300omh! ezeX1*xick+oe onoxooloy80;0?0A00000000000_0000'orOoo}o; I1Fee

eeBeerweRcesees seGeuevesesl ;de ee|eeceyeicescsleds;eC {}gCBK ¢"Pej_1 ee]eceesjecceniecA"e o _eeepm/eeeSpeceesSy
eNefss
ekeele eeoF
SeweeeyeeesSc/) ee6mMNSCCcoeetel:eese Ne~Fee. 2ueecceyiiTe":0];feseceecHeoTeoGjoeecee
ee0 ) B
ecTevr*Qyevyele”
T ee~eee”"5eece. elesee\o| "eBeelerfiyl eLkqee bULeZ2epesePe. [Coot Qei
eLeeTeee(Seedexeel ceeS500ece
TeeeEeeq ' QecWlecelenKee Vpee

~/Desktop

Figure 18 Encrypted data
Once the file is encrypted, we can send the file to the cloud storage system using FTP or SFTP .

Similarly, the decryption process can be carried out by using the commands below. The GNUPG
will prompt for password during the decryption process, use the password that was used to
secure the private key to decrypt data.

e P O]~ 2 3 4 | &
| 2 ~/Desktop/Decrytption.sh - Mousepad
File Edit Search View Document Help
D = ;B C x
1
2 gpg ——-decrypt —output aes_key.bin aes_key.bin.gpg
3

4

5 gpg ——decrypt —output decrypted_data.txt encrypted_data.gpg
6

aes_key.bin
8|

Figure 19 Decryption steps



~/Desktop

gpg: encrypted with 3072-bit RSA key, ID @l1E769F8958ES5A4D, created 2023-08-09
"regin <reginrnairagmail.com>"
File "aes_key.bin’' exists. Overwrite? (y/N) vy

gpg: AES256.CFB encrypted data
gpg: encrypted with 1 passphrase

— ~/Desktop
decrypted_data.txt
Name Regin Raghavan nair

~/Desktop

Figure 20 Decrypted data
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